It Only Looks Easy

®

from the exhibition Chuck Amuck: A Legacy of Laughter
by Mary Erickson, Ph.D.

with Arizona art teacher Kathy David
It Only Looks Easy is a three-lesson unit plan designed in conjunction with the Chuck Amuck exhibition at
the Gallery at Tempe Center for the Arts.
Chuck Amuck Exhibition Preview PowerPoint
Themes
• Theme in Life: We all learn everyday.
• Theme in Art: Artists learn from teachers, from other artists, on their own, from family and from the
world around them.
Key Questions
Lessons approach the themes through two key questions.
How do artists learn how
to be artists?

How do artists use
lines expressively?

Community Connections
Many artists receive inspiration for their art from the world around them. Among Chuck Jones’ inspirations
for his animated cartoons was the Arizona desert. Jones lived in California and often visited Arizona, where
he saw dramatic red buttes and canyons that served as the background for his Wile E. Coyote and Road
Runner cartoons. The happy-go-lucky Road Runner always managed to escape the clever efforts of the ever
optimistic coyote trying to capture him.
Lessons
One: Lots of Ways to Learn (pdf)
Two: Expressive Lines (pdf)
Three: Animals Have Feelings Too (elementary or middle school) (pdf)
Four: Creating Cartoon Characters (high school) (pdf)
Resources
Chuck Amuck Exhibition Preview PowerPoint
Lots of Ways to Learn PowerPoint
Exploring Expressive Lines (pdf)
Animals Have Feelings Too PowerPoint (elementary or middle school school)
Creating Cartoon Characters PowerPoint (elementary or middle school school)

Facial Expressions handout (pdf)
Animals handout (pdf)
Creating Cartoon Characters PowerPoint (high school)
Questor Questions about Chuck Jones’ Drawings (pdf)
Reliquary
Architekton
Chuck Jones Center for Creativity
Warner Bros. Entertainment
Use your web browser to search for stills, videos and cartoons directed by Chuck Jones, for example: Jones’
award-winning 1951 cartoon, “Duck Amuck” or Chuck Jones’ “Extremes and In Betweens.” Many of these
are available in the public domain.
Supplies (Elementary or Middle School)
Drawing paper
Pencils
Marking tools (fine markers, crayons, or colored pencils)
OPTIONAL: Facial Expressions handout (pdf)
OPTIONAL: Animals handout (pdf)
OPTIONAL: cartoon books, book with photos of animals, webpage printout of cartoons or
photos of animals.
OPTIONAL: tracing paper
Supplies (Secondary)
Computer Lab and Adobe Photoshop
Credits
Craig Kausen, Chuck Jones Center for Creativity
Lisa Chow, Desert Dance Theater
Kara Osburn, Reliquery
John Kane, Architekton
Students in Kathy David’s photography classes at Tempe High School
Kelby and B.J. McHardy
Kathy David, Linda Crain, and Mary Erickson for photography
Nancy Erickson, editing
Cartoons and drawings by Chuck Jones courtesy of Chuck Jones Enterprises and Looney Tunes TM & Warner
Bros. Entertainment, Inc.
Estimated Time (Elementary or Middle School)
Previsit Lesson = 30-50 minutes
TCA Visit Lesson = Field Trip
Postvisit Lesson = 60-120 minutes
Estimated Time (Secondary)
Previsit Lesson = 30-50 minutes
TCA Visit Lesson = Field Trip
Postvisit Lesson = 150-200 minutes

Lots of Ways to Learn

®

Lesson One
Objectives
1. Students are able to identify numerous ways that artists learn.
2. Students are able to identify numerous sources for art ideas.
Arizona Visual Arts Standards
EVALUATE: Artworlds: PO 104: Identify and discuss members of the local artworld community.
EVALUATE: Artworlds: PO 204: Discuss the roles of several artworld experts.
EVALUATE: Artworlds: PO 304: Discuss the roles and career paths of numerous artworld experts.
CREATE: Creative Process: PO 101, 202 & 303: Contribute to a discussion about ideas for students’ artwork.
Preparation
Preview Lots of Ways to Learn PowerPoint. Consider using your web browser to locate Wile E. Coyote and
Road Runner cartoons to show how Chuck Jones got ideas from his trips through the deserts of Arizona.
Resources
Lots of Ways to Learn PowerPoint
Chuck Amuck Exhibition Preview PowerPoint
Use your web browser to search for “Wile E. Coyote” and “Road Runner” stills, videos and cartoons directed by Chuck Jones, for example, Jones’ award-winning 1951 cartoon, “Duck Amuck” or Chuck Jones’
“Extremes and In Betweens.” Many of these are available in the public domain.
Activities
Unit Preview: Introduce the theme in life that “We all learn everyday” by discussing how learning can happen both in schools and outside schools.
Introduce the theme in life
“Artists learn from teachers, from other artists, on their own, from family and from the world
around them.”
Introduce the two key questions students will be working with in the unit:
1. How do artists learn how to be artists?
2. How do artists use lines expressively?
Introduction: Display the Lots of Ways to Learn PowerPoint to:
• Introduce the wide range of ways that people, especially artists, learn.
• Illustrate some of the ways that a particular dancer, singer and architect learned to do what
			
they do.
• Introduce the famous animator and director, Chuck Jones, and how he continued to learn
			
throughout his life.

•
•

Identify sources for Chuck’s character Wile E. Coyote.
Briefly introduce expressive lines, which students can find in Jones’ work.

Guided Practice
Consider showing online videos of Wile E. Coyote and Road Runner asking students to identify plants, animals, and landforms inspired by the Arizona desert.
Transfer from Students’ Prior Knowledge
Ask students to identify as many different ways they have learned how to do something as they can, for
example, the rules of a game, a song they like to sing, new vocabulary words, a good joke or trick. Then
focus specifically on what and how they have learned in art. Be sure to discuss the role art teachers, family
members or others may have played in their learning experience. Include trips to an art museum, public
art seen in their community and something they may have learned about art from books, TV, movies, computers or the Internet.
Review and Concluding Remarks
Note that even though Chuck Jones was very successful, he never stopped learning and looking for new
ideas from books, through lots of practice, in school, from radio and phonograph records and from the
world around him.
Transfer to TCA
Explain that students will have an opportunity to see many artworks and cartoon drawings by Chuck Jones
at the Tempe Center for the Arts – or using the Chuck Amuck exhibition online preview.
Arts Vocabulary
Accompany / Accompanied
Animator
Architect / Architecture
Cartoon
Choreography / Choreographer

Choir
Classical Music
Director
Instrument
Silent Movie
Perform / Performance

Photographer
Scale
Sculpture
Serenade
Studio

Extension Idea
CAREERS AND WORKPLACE SKILLS: Introduce the ways people in diverse careers learn how to do their
jobs, emphasizing that they continue to learn throughout their careers.
Assessment Checklist
1. Objective: Students are able to identify several ways that artists learn.
(Discuss during and after presentation, Lots of Ways to Learn PowerPoint)
___ Students can name several ways artists, such as Chuck Jones or themselves, have learned
			
or could learn about art or how to make art.
2. Objective: Students are able to identify multiple sources for art ideas.
(Discuss during and after PowerPoint presentation, Lots of Ways to Learn)
___ Students can name sources for ideas that artists (for example, the dancer, singer, architect
			
and Chuck Jones) got for their art as well as sources they may have used for their own art.

Expressive Lines

®

Lesson Two
Objectives
1. Students are able to compare and contrast lines in artworks.
2. Students are able to explain how expressive lines contribute to the overall character, feeling or
			
mood of an artwork.
3. Students are able to produce lines with different expressive qualities.
Arizona Visual Arts Standards
EVALUATE 3. Elements and Principles: PO 001 & 101: Identify an element [and principle] in an artwork that
supports its meaning and/or purpose.
EVALUATE 3. Elements and Principles: PO 201: Describe how an artist’s use of elements and principles in
an artwork supports its meaning and/or purpose.
EVALUATE 3. Elements and Principles: PO 301: Using established criteria, judge the effectiveness of an
artist’s use of elements and principles in a composition to support the meaning and/or purpose of an
artwork.
RELATE: 4. Meanings and Purposes: PO 001, 101, & 201: Interpret meanings and/or purposes of an artwork
using subject matter and symbols [or themes].
Preparation
Read and make copies of “Exploring Expressive Lines” pdf worksheet.
Make arrangements for field trip to the TCA.
Before your visit, talk with an assigned TCA docent, if possible. Provide the docent with a copy of the
“Exploring Expressive Lines” worksheet in advance of your trip and discuss the extent to which students
might complete any or all of the worksheet at the center or whether any or all of the questions or ideas
might be addressed during their tour.
Read optional “Questor Questions about Chuck Jones’ Drawings” pdf and decide whether you might
want to use it to follow up after a visit to the Chuck Amuck exhibition.
Resources and Supplies
Exploring Expressive Lines (pdf)
OPTIONAL: Questor Questions about Chuck Jones’ Drawings (pdf)
Chuck Amuck Exhibition Preview PowerPoint
Activities
Review and Application: Distribute the “Exploring Expressive Lines” pdf worksheet to all students and ask
them to answer as many questions as they can during their tour. If writing responses on the worksheet is
not practical or possible during the tour, use the worksheet to guide students in focused observation as

circumstances permit. For example, you might use questions on the worksheet when students assemble or
travel to the TCA or when they assemble for or travel back to school.
Take notes on any new information presented by the docent as well as interesting questions, observations
or responses made by students during their tour. If the circumstances of the visit do not allow students to
complete their worksheets, explain that later, in class, you will lead a discussion of discoveries they made
about expressive lines in the exhibition using online Chuck Amuck Exhibition Preview PowerPoint.
Assessment Guides
1. Students are able to compare and contrast lines in artworks.
Students compare and contrast lines in several artworks in the Chuck Amuck exhibition on their
“Exploring Expressive Lines” pdf worksheet.
2. Students are able to explain how expressive lines contribute to the overall character, feeling or
mood of an artwork.
___ Students explain how choice of lines contributes to the character, feeling or mood of artworks
in the Chuck Amuck exhibition on their “Exploring Expressive Lines” pdf worksheet.
3. Students are able to produce lines with different expressive qualities.
___ Students draw several different kinds of lines on their “Exploring Expressive Lines” pdf
worksheet.

Animals have feelings, too

®

Lesson Three: Elementary & Middle School
“Animals Have Feelings Too” is appropriate for elementary and middle school students. Lesson Four,
“Creating Cartoon Characters,” is appropriate for high school students.
Objectives
1. Students are able to give animals human emotions (personification).
2. Students are able to change parts of a drawing to express feelings.
3. Students are able to use lines expressively.
Arizona Visual Arts Standards
CREATE: 3. Elements and Principles: PO 101 & 102: Identify [select] and use elements and principles to
organize the composition of his or her own artwork.
CREATE: 5. Quality: PO 001, 101 & 102: Identify successful aspects of his or her own artwork and possible
revisions.
RELATE: 4. Meanings and Purposes: PO 001, 101, & 201: Interpret meanings and/or purposes of an artwork
using subject matter and symbols [or themes].
EVALUATE: 4. Meanings or Purposes: PO 001, 101 & 201: Discuss how and artist [uses subject matter, symbols and/or themes] communicates meaning and/or purpose in an artwork.
Preparation
Preview Animals Have Feelings Too PowerPoint. Preview Facial Expressions (pdf) and Animals (pdf) handouts to decide whether you will make copies as references for your students. Assemble any cartoon books,
books with photographs of animals or webpage printouts of cartoons of animals you may wish to use to
support students’ learning.
Decide whether you want your students to draw their animals first in pencil and then trace lines directly on
those pencil drawings to change parts and add expressive lines or whether you might want to make (low
contrast) photocopies of their pencil drawings with which students can experiment. Or ask students to
trace their pencil drawings by holding them up to a window to provide more opportunities for experimentation. You also may wish to allow students to color in areas of their drawings.
Resources and Supplies
Animals Have Feelings Too PowerPoint
Drawing paper
Pencils
Marking tools (fine markers, crayons, or colored pencils)
OPTIONAL: Facial Expressions (pdf) handout
OPTIONAL: Animals (pdf) handout
OPTIONAL: cartoon books, book with photos of animals, webpage printout of cartoons or
photos of animals.
OPTIONAL: tracing paper

Activities
Review the theme in life that “We all learn everyday” by retelling what they learned from the work of Chuck
Jones about lines and creating expressive characters. Review the theme in art that “Artists learn from
teachers, from other artists, on their own, from family and from the world around them.” Explain that in
this lesson students will learn how to give animals human features by following the example of Chuck
Jones. Also review the unit’s two key questions: a) How do artists learn how to be artists? and b) How do
artists use lines expressively? Explain that in this lesson they will learn more about how Chuck Jones created cartoon characters and how he used expressive lines.
Definition and Guided Practice
Display the first 11 slides of the “Animals Have Feelings Too” PowerPoint to:
• Show how Chuck Jones changed parts of animals to give them human feelings.
• Define the term “personify.”
• Analyze feelings expressed in a lion cartoon.
• Identify how Jones changes parts of the face of his bookworm to express different feelings.
• Compare lines Jones used in different cartoons.
Step-By-Step Instructions
Display the last seven slides of the “Animals Have Feelings Too” PowerPoint to:
• Introduce the drawing assignment.
• Draw an animal in pencil.
• Change parts of the animal (face and head) to express a feeling.
• Review line choices.
• Trace lines to make them more varied and expressive.
• Show student samples.
In-Process Feedback
Before students add lines to finish their drawing, ask them to partner with one or two classmates to develop ideas for improvement and suggestions about the best kinds of lines to reinforce the feeling of the
drawing.
Presentation
Display the completed animal personification drawings. Lead a discussion with the following questions:
• What parts of the animal has the student changed? How?
• What feeling does the animal express?
• What kinds of lines did the student choose?
Art Vocabulary
Cartoon
Character
Curved / curvy
Dark
Drawing
Exaggerated

Express / expression / expressive
Light
Line
Loopy
Personify
Shape

Size
Straight
Tapered
Thin
Varied
Wide

Assessment Guides
Objective 1. Students are able to give human emotions to an animal (personification).
Exceeds Expectations
The animal drawing clearly and effectively expresses an identifiable feeling.
Meets Expectations
The animal drawing expresses an identifiable feeling.
Approaches Expectations
The feeling expressed in the animal drawing is inconsistent or unclear.
Fails to Meet Expectations
No feeling is expressed in the animal drawing.
Objective 2. Students are able to change parts of a drawing to express feelings.
Exceeds Expectations: Several changes in the animal contribute to a clear and effective expression of
an identifiable feeling in the animal drawing.
Meets Expectations: Several changes in the animal contribute to an expression of an identifiable feeling in the animal drawing.
Approaches Expectations: The animal drawing includes changes to parts of the animal.
Fails to Meet Expectations: The drawing includes no changes in parts of the animal.
Objective 3. Students are able to use lines expressively.
Exceeds Expectations: The animal drawing includes at least three different kinds of lines that reinforces the feeling expressed in the drawing.
Meets Expectations: The animal drawing includes at least three different kinds of lines.
Approaches Expectations: The animal drawing includes at least two different kinds of lines.
Fails to Meet Expectations: Lines in the drawing show no variety.

Creating Cartoon Characters

®

Lesson Four: High School
“Creating Cartoon Characters” is appropriate for high school students with access to digital cameras and a
computer lab with Abobe Photoshop. Lesson Three, “Animals Have Feelings Too,” is appropriate for elementary or middle school students.
Objectives
1. Students are able to use exaggeration to make an expressive artwork.
2. Students are able to use lines expressively.
Arizona Visual Arts Standards
CREATE: Creative Process: 201 & 301: Make and explain revisions of his or her own artwork.
CREATE: Elements & Principles: 201 & 301: Identify, select and use elements and principles to organize the
composition in his or her own artwork.
EVALUATE: Elements & Principles: 301: Using established criteria, judge the effectiveness of an artist’s use
of elements and principles in a composition to support the meaning and/or purpose of an artwork.
Preparation
Because this project requires some advanced Photoshop skills, it is best suited for students with some
prior Photoshop experience. Preview the Creating Cartoon Characters PowerPoint. Read detailed “Step-ByStep Computer Instructions” at the end of this lesson plan to be sure you understand all the steps in the
process.
Resources and Supplies
Digital cameras
Computer lab with Adobe Photoshop
Creating Cartoon Characters PowerPoint
Activities
Review the theme in life that “We all learn everyday” by retelling what they learned from the work of Chuck
Jones about lines and creating expressive characters. Review the theme in art that “Artists learn from
teachers, from other artists, on their own, from family and from the world around them.” Explain that in
this lesson students will learn how to exaggerate features of a photo of themselves and add lines to create a cartoon character of themselves by following the example of Chuck Jones. Review the unit’s two key
questions: a) How do artists learn how to be artists? and b) How do artists use lines expressively? Explain
that in this lesson they will learn more about how Chuck Jones created cartoon characters and how he used
expressive lines.
Introduction and Definition
Display the first ten slides of “Creating Cartoon Characters” PowerPoint to:
• Define and give examples of exaggeration.
• Analyze how lines can increase the expressiveness of an artwork.

Assignment
Explain to students that they are to demonstrate what they have learned by transforming a digital image of
themselves into an expressive cartoon through exaggeration and addition of line.
Step-By-Step-Instructions
View remaining “Creating Cartoon Characters” PowerPoint slides to show steps in creating a cartoon character and also to show several high school student samples:
1. Create a canvas, upload a photograph of yourself and remove the background.
2. Use a filter called “liquify” to exaggerate facial features, apply emotions and alter body shapes.
3. Several steps are required to achieve this cartoon effect (including applying a surface blur filter).
(See detailed step-by-step instructions at the end of this lesson plan.)
4. Add the finishing touches to your cartoon by creating lines for definition. Then lighten the image
with levels.
Art Vocabulary
Angular
Brighter
Cartoon
Character
Curved / curvy
Darker
Exaggerate / exaggerated

Express / expression / expressive
Larger
Lighter
Line
Longer
Loopy
Rounder

Shape
Size
Straight
Tapered
Thin
Varied
Wide

Secondary Assessment Guides
Objective 1. Students are able to use exaggeration to make an expressive artwork.
Exceeds Expectations: The exaggerations in the cartoon powerfully and effectively express an overall
mood, feeling or emotion.
Meets Expectations: The exaggerations in the cartoon suggest an overall mood, feeling or emotion.
Approaches Expectations: The cartoon includes some exaggeration of parts.
Fails to Meet Expectations: No parts of the cartoon have bee exaggerated.
Objective 2. Students are able to use lines expressively.
Exceeds Expectations: The lines effectively enhance the cartoon’s expression.
Meets Expectations: The lines add to rather than distract from the cartoon’s expression.
Approaches Expectations: The cartoon includes added lines.
Fails to Meet Expectations: The cartoon includes no added lines.

Chuck Jones Project
Step-by-Step
1.

Duplicate background layer
Layers Panel>Drag layer to “Create New Layer” icon

2.

Use liquify to exaggerate facial features, apply emotions and alter body shapes
Menu bar>filter>liquify
(Dialog box: Forward warp tool – top tool on the left.)
Nudge a little at a time.
Or

1.

Enlarge or shrink a feature
Tool box>Polygonal lasso tool
Menu Bar>Layer>New>via copy
Menu Bar>Edit>transform>Scale
(Use the clone stamp to remove the original feature)

Create Cartoon Effect
This effect is a slightly modified version from Corey Barker’s video “Stylized Comic Book Effect” published
on www.planetphotoshop.com.
1.

Remove textures but retain edge definition
Menu bar>filter>blur>surface blur
(Set radius and threshold for desired effect)

2.

Duplicate layer
Layers Panel>Drag layer to “Create new layer” icon

3.

Remove color from layer
Shft + Cntrl + U

4.

Load luminosity as a selection
Channels panel>cntrl>click on RGB layer

5.

Turn off top layer
Layers panel>click off eyes

6.

Remove values and create value shapes
Menu bar>filters>artistic>cutout
Dialog box>Number of levels (8), edge simplicity (0), Edge fidelity (3)

7.

Duplicate color layer
Blending Mode in layers panel>soft light

8.

Activate Gray Scale Layer
Layers panel>Click on eye

9.

Add lines
Menu Bar>Filter>Artistic>Poster Edges
(Dialog Box: Set all sliders to 1 – you may experiment to get the best effect)
Blend Mode: Multiply

10.

Lighten image
Menu bar>Image>Adjustment>levels>push white slider to left as needed

